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About the Author

Michael Di Lauro, CPA CMA, Hein & Associates CPAs

Michael is a CPA, CMA with a strong background in training and technology. Over the years
Michael has written dozens of training materials and has taught QuickBooks, ProFile,
Microsoft Office and other software applications to thousands of individuals. When not
teaching or training you’ll often find Michael in various coffee shops, throughout Ottawa and
Montreal, discussing business and technology with friends, clients and, even, perfect
strangers.




ADDITIONAL RESOURCES

In addition to this document, Intuit provides numerous resources to accounting professionals. Refer to these sites to explore
additional tutorials and training opportunities:

e  http://accountant.intuit.ca/professional-accounting/index.jsp
e http://profile.intuit.ca/professional-tax-software/index.jsp
e  http://profile.intuit.ca/professional-tax-software/training.jsp




Introduction

Intuit ProFile Tax software is reliable and easy-to-use, and it offers sophisticated features that help tax preparers
experience a more productive tax season. The following paragraphs summarize the key components of Intuit
ProFile Professional Tax software

ProFile T1 imports and converts data created by competing software products. Whether you carry files forward
individually or in batches, you will find the process quick and convenient. Using ProFile’s WYSIWYG (what you
see is what you get) forms, you can view and edit federal T1 and Québec TP1 forms in either French or English.
You can also print all tax forms in either language at the click of a button.

ProFile T2 is designed for professional preparation of corporate tax returns in all provinces and territories. ProFile
T2 includes:
e Federal T2 returns, including T2 RSI (for 2006-2009 and earlier) and Corporation Internet Filing
e Provincial corporate tax returns for Alberta (including AT1 RSI), for Ontario returns with taxation
years ending prior to January 1, 2009 (including CT23 disk filing) and for Quebec (CO-17).
e Provincial capital tax returns for Manitoba, Saskatchewan and British Columbia

ProFile T3 prepares Trust income tax returns and supporting schedules, including T3 and TS slips that the trust
receives. Simply enter slip information on intuitive income-reporting screens and ProFile T3 automatically
transfers the amounts to the appropriate forms. ProFile T3 also integrates business and rental income statements.
In addition to T3 slips, the software allows you to prepare NR4 slips for non-resident taxpayers (including the
NR4 summary).

ProFile FX (Forms Expert) gives you more than 80 of the most commonly-used CRA forms which supplement
the form-sets in Intuit’s other tax applications. Here are a few highlights of ProFile FX:

Customizable options help you complete and file the forms you need.

Automatic form selection facilitates form printing.

Audit and review features help pinpoint potential errors

Forms flexibility lets you print facsimile forms on plain paper or directly onto pre-printed CRA forms.
ProFile FX also prepares magnetic media files for T4, T4A, T5, T5018 and NR4 slips, as well as for the
RL1, RL2, RL3 and RL4.

e Import identification from an existing ProFile T1 or T2 data file minimizes potential data entry errors.



Benefits of Using ProFile

ProFile is powerful, efficient and secure tax software that helps you get your work done fast and efficiently.
Here’s how you benefit by using Profile:

e With phone, email or in-product live chat support, you have year-round access to knowledgeable
Canadian technical experts

e With its comprehensive set of forms and schedules, ProFile lets you handle just about every tax
scenario in any jurisdiction, including Québec

e  With a built-in auditor that runs up to 2,800 diagnostic checks of your tax returns, ProFile has your
back

e Flexible Licensing means you can install ProFile on more than one personal computer without having
to pay additional licensing fees

e Work with QuickBooks? So does ProFile! There’s no need for manual data entry because you can now
export data from QuickBooks directly into ProFile

Plus, with ProFile you enjoy a consistent level of advanced features that include:

e Customizable client correspondence
e Database queries and reporting
¢ Online tools to quickly and easily stay in touch with your clients




Chapter 8: Advanced Features

CHAPTER 8 LEARNING OBJECTIVES

At this chapter’s conclusion, students will understand:
e The purpose of a file template
e The various ways to attach ancillary documents to a T1
e How to pay CRA using T1 PAD

FILE TEMPLATE

If you find that you are constantly checking the same boxes on ProFile’s Info page (for example, the Elections
Canada question), or if you find that most of your clients live in the same city or province, you can setup a file
template that automatically fills in certain fields with a uniform set of data. This capability is called a file template
and, once you’ve set it up, Profile automatically fills in the fields of any new tax as specified in that template.

In addition to pre-filling fields that you specified in the template, you can also set the forms (and the sequence of
forms) you want ProFile to open when you first create a new file. You can create a separate file template for each
ProFile module.

Note: When you carry forward prior-year files, information from the previous year will always overwrite any file
template data.

To create a file template:
e Create a new tax return.
e Enter data into any field on any form. The example below has data for City and Province, as well as
Canadian Resident, Elections Canada, and Language fields
e Open any forms that you want ProFile to open automatically when you create a new client file that is
based on this file template



[o]e =y

371013 | @451 | (85T3| (8 6T4| (8275 | @ & RRSP/PRPP |  +

0 g common-law at any
time in this tax year? r] Yes D No
Residency

Care of
Street address Apt #

IRR

Province of residence

on 2016/12/31 Ontario

M Province of self-employment

If you became or ceased to be a Canadian resident in

2016, enter date of: entry mm-dd
or departure  mm-dd

Birth date yyyy-mm-dd A 0
Date of Death _ yyyy-mm-dd

Gender |:| Male |:| Female

Province or territory where taxpayer resides if different from mailing
address:

By providing an email address, | understand

| am registering for online mail and accept

Are you a non-resident? D Yes No
™ Residency status Resident
Country (other than Canada)

R - Did you dispose of a property (or properties) in 2016 for which you ar
Gic f(.)llowmg VG ET Cariizms: ‘:l Yes D No claiming a principal residence exemption? |:| Yes No
Email address:
Use preparer address for:

Nothing |:| Notice of Assessment and Refund |:| Nof A
D T1 mailing address

EFILE this retum?
EFILE multiple years?

Authorization for efiler to represent taxpayer?
First time filer in 2016?

Method of contact for: P

in 2016 with a total cost of more than
CANS$100.000?

Contact preparer by mail L] Is taxpayer's income zero?

Contact client Claim disability amount?

Is return discounted? ﬂ Yes No If yes. is this a first year claim?

Is return completed under the CRA's Mentally or physically infirm?

volunteer program? |_| Yes No Indian within the meaning of the Indian Act?
Were you confined to a prison or similar institution Is this an Early Filed or Elective deceased

for a period of 90 days or more during the year? return?

(Schedule 6. ON479 & GST / HST Credit) D Yes No Subsection 104(13.4) election to have certain
If your province or territory of residence changed income taxed on the & hedaceased
in 2016, enter the date of your move. yyyy-mm-dd gwenerary, rather than on a T3 return

Language of correspondence English

e as the

.I‘sMom res
e Save the file. Name it something like 7/ Template

Wl Save 2016 T1/TP1 As ? X
1. NoName
NoName
Client Status: | 2. Work in process v [JLocked
EFILE Status: 1. Noteligible v
SEND Status: | 1. Not Eligible v
TP1 Status: | 1. Noteligible v
T1135 Status: | 1. Noteligible v
DCN: \ |
Invoice: \ | Time: [00:00:00 |

[]Discounted? [JCRAEmors 2139

File Name
[ne\Documents\My ProFile Date\Templates\T1_TEMPLATE 16T| | -
Online Backup Disable:

Conc

Help Advanced >>

e Go to the Options menu and select Module

e Click the Browse button beside the File Template field, search and select the T/ Template file on your
hard drive




V4 Open X

A || « MyProFileData > Templates v ®/| | Search Templates »
Organize v New folder =~ W O
A Name ° Date modified Type
# Quick access
2017-10-094:10AM  ProFile 2016
B Desktop @ T1_TEMPLATE 1 10AM  ProFile 2016 T1
¥ Downloads
= Pictures
[ iCloud
. Dropbox
2016T1
Autosaved Capti
PendingCapture
Training Guides
& OneDrive
v < >
File name: | T1_TEMPLATE v| [2016ProFile 1 (167 v
Open Cancel
o Click OK
Module Options ? X
B 22016 T1/TP1 v|id 32052017 T2 v | 52016 T3/TPe4s v | [ 22017 P [
File Template
[PocumentsMy ProFile Data\Templates\T1_TEMPLATE.16T | | Browse

General DatalLocking Variance Disclaimer T1/TP1 Review

€ Carry forward files ||  Lenguage
Xl Cany forward slip descriptions @® English
[X] Carny forward donation descriptions OFrench
3] Carry forward free form notes
O Cany forward preparer initials
[ Cany forward partner initials
O Carry forward reviewer initials
Xl Carny forward authorization question
[ Cany forward Elections Canada question
[ Cany forward foreign property question
[ Cany forward files to same location as previous year
[ Camy forward invoice description of services —_—
O Carzfovward T1DD |n10rmat?on "
© RC59 online access default v ance!
< ed Help

e ProFile will use the default settings in this template file whenever you create a new file of the same
type. If you want to share the template with other users on a network, save the template into a shared
server folder.

¢ In Client Explorer, files display by client name or SIN. On a template, both these fields are blank, so,
when you look for your template on the Client Explorer, the template file appears as NoName.

e Select the NoName file in the database client list. Below it, you will see the file name you assigned,
such as T/ Template, in the file details area.

e Open the template when you need to modify the defaults for all your new clients.

HyPERDOCS

It may happen that you’d like to attach or link an electronic document to a tax file. You may, for example, want to
attach a PDF of a CRA document such as a tax ruling or an interpretation bulletin. Or you may want to link to an
image file itemizing details of charitable donations or medical receipts. With ProFile’s HyperDocs, you can do
exactly that. In other words, you can attach multiple documents, in any format, to a form or field of a T1 return.

It’s important to note that any HyperDocs document attached to a tax file will be stored for internal purposes only.
This means that no HyperDocs attachment will ever get transmitted to CRA.



Adding a HyperDocs document
You can choose to attach a HyperDocs to a tax file or to a specific form—or any line on a form—in a tax file.
e To add a new HyperDocs document to the tax file itself, go to File > HyperDocs and click the Add icon

(circled in the image below)
e A window will then open, letting you select the file you wish to add

| HyperDocs ? X
Attach or link documents to this return O [N x]

1. StLaurent Marianne

HyperDoc Size Outof.. DateLinked Date Modified Type  Fom ‘

Comments (for your reference)

i Select Files X
« v 1 @ > OneDrive > v o »
Organize ~  New folder - m

v s Quick access
@ Attachments

m Desktop  #
& Client Docs
& Downloads  #
& Pictures
@ Pictures A
< iCloud *

2016T1
Autosaved Captt

PendingCaptures

T2 Returns
> & OneDrive
= This PC v < >
File name: <| | AllFiles (%) s

e To attach a HyperDocs to a specific field on a client form, right-click on the field and select A¢tach
HyperDocs

Step 2 - Total income
As a resident of Canada, you have to report your income from all sources both inside and outside Canada.
When you come to a line on the return that applies to you, go to the line number in the guide for more information.
Employment income (box 14 of all T4 sips) 101] [EREF e
Commissions included on line 101 (box 42 of all T4 sips) [102] ojoo | Help Fl
Wage loss replacement contributions. B 14 6
(see lne 101 in the guide) 103 oloo § TR
Other employment income 104 U]
0Oid Age Security pension (box 18 of the T4A(OAS) slip) 113 0] Cut
CPP or QPP benefts (box 20 of the TA(P) slip) 114] o| Copy
Disabilty benefis included on line 114
(box 16 of the T4A(P) siip) [152] oloo § Copy field code
Other pensions and 115] of  Paste
Elected spit-pension amount (attach Form T1032) 116 0 ~
Override F2
Universal Chid Care Benefit (UCCB) 117
UCCB amount designated to a dependant 185 ojoo §f Attach memo F8
Employment insurance and other benefits (box 14 of the T4E siip) [119] 0 Attach tape Ctrl+F8
Taxable amount of dividends (eligible and other than eligible) from taxable Canadian Copy Memo/Tape
corporations (attach Schedule 4) Py P
Taxable amount of dividends other than eigible dividends,
included on line 120, from taxable Canadian corporations [180] oloo § Attach HyperDoc
Interest and other investment income (attach Schedule 4) 121 P — 5
Net partnership income: limited or non-active partners only 122 0
Close form Esc
Registered disabilty savings plan income 125] 0
Print form
Rental income Gross [160) oloo § Net[126 0 New window
Taxable capital gains (attach Schedule 3) 127 0.
Launch window
Support payments received Total[156] oloo § Taxable amount 128 0 Crente X
RRSP income (from all TARSP slips) 129 0 reste
Other income Specify: 130) 0 Create T3
Self-employment income Carry forward
Business income Gross [162] 0]00 Net[135] 0 Py e
Professional ncome Gross[164 0[oo Net[137 0 b
Commission income: Gross|166) 0/00 Net|139) 0 Show auditor Ctrl+F9
Farming income Gross [168] 0]o0 Net[141 0 i
Fishing income Gross|170) 0]o0 Net|143) 0

e After you select the file, ProFile asks whether to embed or link your document




w4 HyperDocs ? X

(O Embed Document Copy
(® Link Document

e Embedded documents open as read-only and cannot be edited in ProFile

e Linked documents open from the source, so you can edit them directly in ProFile, and your changes
will be saved to the source document on your computer

Managing attached documents via HyperDocs

Whether you add a HyperDocs to the tax file in general or to a specific area of the tax file, you will find all
attached documents in the HyperDocs window. To view all attached documents:

e Goto File > HyperDocs

e All attached documents appear in the HyperDocs window along with any comments that you entered.
The HyperDocs window also lists key information that includes:

e The date the document was attached and/or modified

e The process you chose to attach the file (linked or embedded)

¢ And the form to which the document was attached

4 HyperDocs ? X

Attach or link documents to this return NN X

1. St Laurent, Marianne

HyperDoc Size Outof.. DateLinked Date Modified Type Form

|S]ProFile 2017 License.png 19KB  No 20171217 3:.07:38PM ~ 2017-10138:48.00AM  Embed. T1:10
IE] Uber.png 206KB  No 20171217 3.0214PM 20171117 550:30AM  Embed..  Tax Retun

Comments (for your reference)

Close Help

Removing a HyperDocs document

e Toremove a HyperDocs document, right-click on the document in the HyperDocs window and choose
Remove



vl HyperDocs ? X

Attach or link documents to this retum CH a
1. St Laurent, Marianne
HyperDoc Size Outof.. Date Linked Date Modified Type Form
|S]ProFile 2017 License.png 19KB  No 20171217 3.07:38PM ~ 2017-10138:48:004M  Embed..  T1:101
|S]idBer pna 206KB  No 20171217 3.0214PM  2017-1117550:30AM  Embed..  TaxRetum
Add Ctrl+D
Open embedded Ctrl+0
Open Source Ctrl+U

Synchronize Ly

Remove Ctrl+R

Go To Field

Icons

'  Details
Comments (for

Refresh F5

Close Help

Deleted forms

If you delete a form that had HyperDocs attached to it, the HyperDocs will also be deleted. Deleting a HyperDocs
document will only remove the link or embedded document from ProFile - it will not affect the source file stored
on your computer.

Opening attached documents

From the HyperDocs window, double click on the document. If the document is linked, ProFile opens it from its
source and saves any changes you make directly to the source file stored on your computer. If the document is
embedded, ProFile opens a read-only version.

You can keep HyperDocs documents open while you continue working in ProFile.

Synchronizing out-of-date documents via HyperDocs

If you alter a linked document outside of ProFile, may to synchronize the document so that ProFile has the latest
version of the file.

e Because embedded documents open as read-only, to make changes to an embedded file, you must edit
the source file and synchronize it in ProFile

® You can edit linked documents directly in ProFile, as they open from the source and your changes are
saved to the source file

Any out-of-date, or unsynchronized, documents are displayed in red in the HyperDocs window along with an
exclamation point icon.

e To synchronize an out-of-date file, right click the document and select Synchronize




w4 HyperDocs

Attach or link documents to this retum

1. St Laurent, Marianne

HypeDoc

|E] ProFile 2017 License.png
%) Profit & Loss.xlsx

|EJ Uber.png

Comments (for your reference)

Size Outof .
19KB  No
9KB Yes
206KB  No

Date Linked

20171217 3.07:38 PM
20171217 3:2411 PM
20171217 3:02:14 PM

Date Modified

2017-10-13 8:48:00 &AM
2017-1216 2.32.05 PM
2017-11-17 5:50:30 AM

Type

Embed..

Linked
Embed

? : X
Form

T1:101
T1:104
Tax Retun

Close Help

e Once ProFile has synchronized the document, the exclamation point will disappear, and any red

lettering will revert to black font

VARIANCE AND SNAPSHOT

Variance is a feature that you use to highlight significant changes on a tax return. Variance lets you experiment
with different scenarios and quickly identify the impact of a change on many key fields. Variance is only
calculated for fields with CRA line numbers. So, not all fields (for example on worksheets) will be included in the
variance comparison. You activate the variance feature by taking a snapshot of the tax return.

To take a snapshot of your current return

e From the Audit menu, select Snapshot/variance and click the New button. This will take a picture of the

current contents of the tax return

e Give the snapshot a name that will remind you of the purpose of the scenario
o Select the Activate this snapshot option to have ProFile compare any changes you make in the file to

this snapshot and click OK

Active: None
Description
None

Preparer

Date

Take snapshot

Description:

i lWhat if scenario

Preparer:

[MDL

Activate this snapshot

Cancel

Delete
Close

Help




e Asyou make changes in the file, you can see the variance analysis on the Variance tab of the Active
Auditor

»

& Summary ® Wamings @ Notices « Sign-offs X lIssues Overrides Memos ¥ EFILE o T1135 (= Online *

. Variance T1 Line 101: Employment income - What if scenario: $18,421.00 (increase of $25,901.00 / 140.6%) "~
. \Variance T1 Line 150: Total income - What if scenario: $18,421.00 (increase of $25,901.00 / 140.6%)
. Variance T1 Line 234: Net income before adjustments - What if scenario: $18,421.00 (increase of $25,901.00 / 140.6%)
o \Variance T1 Line 236: Net income - What if scenario: $18,421.00 (increase of $25,901.00 / 140.6%)
. Variance T1 Line 260: Taxable Income - What if scenario: $18,421.00 (increase of $25,901.00 / 140.6%)
& \Variance S1 Line 323: Your tuition, education, and textbook amounts - What if scenario: $4,701.10 (increase of $6,806.90 / 144.8%)
& \Variance S1 Line 335: Unadjusted federal non-refundable tax credits - What if scenario: $18,421.00 (increase of $6,814.08 / 37.0%)
EFILE: Eligible |Balance/Refund  4,491.47 |GST Credit 32.35 |Combined bal...4,491.47 +
And Iso vi he ch in ‘fl ’ h i 11 i
° nd you can also view the ¢ anges I 1ly-over: messages when your cursor 1S over a yellow variance
field

Step 2 - Total income
As a resident of Canada, you have to report your income from all sources both inside and outside Canada.
When you come to a line on the return that applies to you, go to the line number in the guide for more information.

income (box 14 of all T4 slips)

101 44_322|OOIi \What if scenario: $18,421.00
c included on line 101 (box 42 of al T4 slips) 102 oloo § i of §25,901.00/ 140.6%)

'Wage loss replacement contributions

(see line 101 in the guide) 103 0|00 i

Other employment income [104 m_!
0Id Age Security pension (box 18 of the T4A(OAS) slip) [113] 0[00
CPP or QPP benefits (box 20 of the T4A(P) slip) 11 ojoo |

Disabilty benefits included on line 114

Shelf-life of a snapshot
Snapshots may have a short self-life. For example, you may have created a snapshot last week using a client
RRSP contribution of $5000. This week you may want to evaluate the impact of reducing that contribution to
$3000.
However, if you also added a new T3 slip since taking the first snapshot, variance will detect the impact of both
the T3 and the RRSP contribution change. To best use variance, make sure you carefully manage which data
fields you've changed since taking a snapshot that you want to use for comparison.

Deleting a snapshot
If you change other data in the return, like adding income from a forgotten contract job, you will need to delete

your original snapshot and create a new one, reflecting the extra income, before comparing that scenario to

current data.
On the Snapshot Variance dialog (go to the Audit menu and select Snapshot/variance, select a snapshot

[}
that you no longer need and click the Delete button to remove that snapshot.
Snapshot / variance for St Laurent, Marianne X
Active: What if scenario
Description Preparer Date
None
‘What if scenario MDL 2017-12117




Previous year variance

ProFile includes several features to help you identify and analyze variances between two tax scenarios. If you
carry forward information from a previous year's return, you can use these variance features to find out how much
a field changed in comparison to the previous year.

To turn on previous year variance:
¢ Go to the Options menu and select Module
Click a module tab, for example, 201671
Click the Variance tab.
Select the Show previous year variance by default checkbox
Click OK

Module Options ? X

W 22016 T1/TP v] 320152017 T2 v | &l 52016 T3/TPe46 v | @ z2017Fx < |*
File Template

[ l Browse

General Datalocking Yariance Disclaimer T1/TP1 Review

Minimum Variance Language
Dollar ($) 500 2 @® English
Percentage = OFrench
Show previous year variance by default
Cancel
Help

When you carry forward a return and there is a difference between the previous and current year amounts, ProFile
highlights the changed fields with an orange background. Move your cursor over the field to see the message
associated with that field.

Variance thresholds

You can set variance thresholds to meet your own requirements. Go to the Options > Module and click the
Variance tab.

Set a minimum dollar value or percentage of change that will trigger a variance calculation. If you set both a
dollar and a percentage amount, ProFile calculates a variance only when the amount differs by more than the
dollar value and the minimum percentage.



Module Options ? X

22016 T1/TP1 v|l320152017 T2 w | & 52016 T3/TPe46 v | [&d 22017 Fx « | »
File Template
[ | Browse

General Datalocking Variance Disclaimer T1/TP1 Review

Minimum Variance Language

Dollar () 10000 = @® English
Percentage (%) 10 L OFrench

[[] Show previous year variance by default

Cancel

Help

T1PAD

Pre-authorized debit (PAD) is a secure, online, self-service payment option for individuals and businesses. This
option lets you set the payment amount you authorize CRA to withdraw from a Canadian chequing account to pay
taxes on a date, or multiple dates.

Due to the processes that must take place between the CRA and the financial institution, the selected payment
date must be at least five business-days from the date your PAD agreement is created or managed.

A PAD agreement can only be done online. Here’s how to do it in ProFile:

e Use Form Explorer to Open T/PAD
e Type Yes to set up PAD
e  Click the Pay in full checkbox
e Ifyou are already set up for Direct Deposit and you want to pay from that account, enter YES.
Otherwise enter NO and enter the bank transit info
\/4 2016 T1/TP1: TaxPayer, Gavin - Pre-Authorized Debits form oo ==

@1info |@2T1| 8374|8573 F6T8s 1.TIPAD | +

| Pre-Authorized Debits (PAD) |

Do you wish to set up Pre-Authorized Debits (PAD) for current year tax owing? Yes

Instructions

* Pre-authorized debit (PAD) is a secure, online, self-service payment option for individuals and businesses. This option lets you set the
payment amount you authorize the Canada Revenue Agency (CRA) to withdraw from your Canadian chequing account to pay your taxes on
a date you choose

* Only Payment on Filing (POF) for the current tax year will be allowed to create PAD agreement through T1 Efilers.

 To Efile PAD-Agreement: Go to the Efile Menu and select "Efile Pre-Authorized Debit for this TaxPayer”

[ First name ] Last name ] Social insurance number
[Gavin B raxPayer | 444 444 442

Total amount owing

7.830)41 i

Complete the banking information area below

Total amount you would like to pay through PAD (single one time payment)

Pay in full 7.830[41 |}

Do you want to use the same banking information entered in T1DD (Direct deposit) form? No
Branch number | Institution | Account number | Payment date ]
(5 digits) (3 digits) (maximum 12 digits) | (YYYY/MM/DD) |
[12334 016 123345554311 | 2017-12-31 |
T1PAD confirmation number. [ ]
Modified EFILE: Not eligible |Balance/Refund 7,830.41 | GST Credit 0.00 |Combined balan...13,803.35 +




e Next, go to EFILE and select EFILE Pre-Authorized Debit for this Taxpayer
e Once EFILED, ProFile will record the TIPAD confirmation number in the yellow field above, and on
the INFO form as well

EFILE Online Training Window Help
EFILE/ReFILE this return... Ctrl+F11
EFILE Pre-authorized Debit for this taxpayer...
EFILE the T1013 for this taxpayer...
EFILE the T1135...
Build T1 EFILE Online Batch...
EFILE Online Batch
Build TP1 NetFile...
TP1 Connect...
Reports >
Print All ACKs
View Notice of Assessment (ENOA)
Set EFILE Password

Options...




Chapter 8 Quiz

Question 1: A file template is used to:

Ensure that all data is recorded properly

Create returns for various family members

Pre-select the fields and forms ProFile will set up on a new tax return
Verify the accuracy of the tax amounts
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Question 2: True or False: A different file template can be set up for each ProFile module

Question 3: HyperDocs is designed to:

Link or embed an electronic file to a tax return

Add audit messages to a tax file

Link an amount on a tax return to the relevant information on CRA’s website
Create a hyperlink that can be emailed to a client
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Question 4: True or False: You can use HyperDocs to send documents such as donations receipts to CRA

Question 5: True or False: HyperDocs lets you attach a document to either the tax return itself or to a line on the
return

Question 6: You synchronize a Hyperdocs file by clicking:

On the Synchronize command in the File menu

The source document in Windows Explorer

On the green Synchronize icon in the HyperDocs window
You cannot, in fact, synchronize a HyperDocs file
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Question 7: True or False: Once you attach a HyperDocs file to a tax return, you cannot remove it




Question 8: True or False: Profile uses a Snapshot to EFILE the tax return to CRA

Question 9: Select one reason you would use ProFile’s Variance feature:
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To compare the difference between two spouses’ T1 files

To highlight significant changes between the prior and current year’s T1 files
To track the last time you opened a T1 file

To make sure all tax preparers are using the same version of the tax file

Question 10: CRA’s T1 Pad is used to
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Send an electronic payment to CRA

Keep track of all amounts already paid to CRA
Ensure that all client notes are saved in a notepad
Modify a file that you EFILED with CRA







